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FAILURE OR IMPROPER SELECTION OR IMPROPER USE OF THE PRODUCTS DE-
SCRIBED HEREIN OR RELATED ITEMS CAN CAUSE DEATH, PERSONAL INJURY AND 

PROPERTY DAMAGE.

This document and other information from Parker-Hannifin Corporation, its subsidiaries and 
authorized distributors provide product or system options for further investigation by users 

having technical expertise.

The user, through its own analysis and testing, is solely responsible for making the final selection 
of the system and components and assuring that all performance, endurance, maintenance, 

safety and warning requirements of the application are met. The user must analyze all aspects 
of the application, follow applicable industry standards, and follow the information concerning 

the product in the current product catalog and in any other materials provided from Parker or its 
subsidiaries or authorized distributors.

To the extent that Parker or its subsidiaries or authorized distributors provide component or 
system options based upon data or specifications provided by the user, the user is responsible 
for determining that such data and specifications are suitable and sufficient for all applications 

and reasonably foreseeable uses of the components or systems.

WARNING — USER RESPONSIBILITY
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A B

D*FE

Ordering Code

Nominal
size

Direct. 
control 
valve

Spool-
type
(see 

catalogue)

Command-
signal

Y-port 
(plugged) 1)

Seal Design 
series
(not re-

quired for 
ordering)

Spool 
position 

on power 
down

Elec-
tronics 
option

Code Signal Function

B +/- 10 V 0...+10 V -> P-A

E +/- 20 mA 0...+20 mA -> P-A

K +/- 10 V 0...+10 V -> P-B

S 4...20 mA 12...20 mA -> P-A

D F E C 9 3

Spool/
body 

design

Code Seal

N NBR

V FPM

H for HFC fluid

Code Size

1 NG06 / CETOP 03

3 NG010 / CETOP 05

Code
Spool position on 

power down

C

1) Needs to be removed at tank pressure >35 bar.

Code Connection

0 6 + PE

5 11 + PE

7 6 + PE + Enable

1. Introduction



Prop. Directional Control Valve
Series DFplusOperation Manual

5 Parker Hannifin Corporation

D_F_30 5715-687 UK.indd 16.09.21

Code
Spool position on 

power down
Code

Spool position on 
power down

A 3) H 5) 6) a 0 b

A B

P T

B 3) J 5) 6) a 0 b

A B

P T

C 4)

A B

Y

D*FP

Ordering Code

Nominal
size

Direct. 
control 
valve

Spool-
type
(see 

catalogue)

Command-
signal

Y-port 
(plugged) 2)

Seal Design 
series

(not 
required for 

ordering)

Spool 
position 

on power 
down 1)

Code Nominal size

1 NG06 / CETOP 03

3 NG10 / CETOP 05

Code Connection

0 6 + PE

5 11 + PE

7 6 + PE + Enable

Code Signal Function

B +/- 10 V 0...+10 V -> P-A

E +/- 20 mA 0...+20 mA -> P-A

K +/- 10 V 0...+10 V -> P-B

S 4...20 mA 12...20 mA -> P-A

D F P 9 0

Spool/
sleeve 
design

Code Seal

N NBR

V FPM

H for HFC fluid

1)	 On power down the spool moves in a defined position.  
This cannot be guaranteed in case of single flow path on the control edge A – T resp. 

	 B – T with pressure drops above 120 bar or contamination in the hydraulic fluid.
2) 	 Needs to be removed at tank pressure >35 bar.
3) 	 Approx. 10 % opening, only zero lapped spools and underlap spools.
4) 	 Only for overlapped spools.
5) 	 D1FP: Flow for code M: 35 l/min at ∆p 35 bar.
6) 	 Only D1FP

Elec-
tronics 
option
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A B
Y

Code
Spool position on 

power down

A 1)

B 1)

C 2)

D30FP

Ordering Code

Nominal
size

NG10 / 
CETOP 05

Direct. 
control 
valve

Spool-
type
(see 

catalogue)

Command-
signal

SealSpool 
position 

on power 
down

D 30 F P 3

Code Inlet Drain

1 3) internal external

4 internal internal

Pilot con-
nection

Design 
series
(not re-

quired for 
ordering)

Spool/
body 

design

Code Seal

N NBR

V FPM

H for HFC fluid

1) Approx. 10 % opening, only zerolapped spools.
2) Only for overlapped spools.
3) For tank pressure >35 bar.

Code Signal Function

B +/- 10 V 0...+10 V -> P-A

E +/- 20 mA 0...+20 mA -> P-A

K +/- 10 V 0...+10 V -> P-B

S 4...20 mA 12...20 mA -> P-A

Elec-
tronics 
option

Code Connection

0 6 + PE

5 11 + PE

7 6 + PE + Enable
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µC

Parametrizing
interface

Command

Diagnostic
spool stroke

Supply
VoltagePE

0...±10 V

22...30 V=

Reference1)

0 V

0...±10 V

4...20 mA
0...±20 mA

B, K:

S:
E:

Reference

µC

Parametrizing
interface

0...±10 V

22...30 V=

Command

Diagnostic
spool stroke

Supply
VoltagePE

+5...30 V=
Enable

Reference1)

0 V

0...±10 V

4...20 mA
0...±20 mA

B, K:

S:
E:

Reference

Characteristics of Valve Driver 

The integral electronic driver combines all func-
tions for optimal operation of the valve. Thanks 
to its excellent dynamic the valve is deployable 
within closed loop control applications. The most 
important features are: 

•	 high dynamic actuator with specially designed 
electronic driver 

•	 closed loop controlled spool position 
•	 constant current actuator control with overcur-

rent shutoff 
•	 excellent properties for response sensitivity and 

temperature drift 
•	 differential input stage with various command 

signal options 
•	 diagnostic output for spool stroke / overcurrent 

state 
•	 meets relevant European EMC-standards

Name Plate Block Diagram of Onboard Electronics

Code 0 (6+PE)

Code 5 (11+PE)

Code 7 (6+PE with enable)

hydr. spool symbol
order code
nominal pressure

µC

Parametrizing
interface

0...±10 V

22...30 V=

+5...30 V=

Command

Diagnostic
spool stroke

Supply
VoltagePE

Enable

0...±10 V

4...20 mA
0...±20 mA

B, K:

S:
E:

Reference1)

0 V

1) Do not connect with supply voltage zero.
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Technical Data

General
Model Proportional directional control valve, direct operated (D*FE, D*FP), 

pilot operated (D30FP)
Drive VCD®-actuator
Mounting interface NG06 (CETOP 03) / NG10 (CETOP 05)
Installation position D*FE, D*FP: unrestricted; D30FP: horizontal mounting preferred 

(other mounting positions after consultation)
Sensitivity [%] < 0.03
Hysteresis [%] < 0.05 (D*FE: <0.1)
Temp. drift of center postion [%/K] < 0.025
Ambient temperature [°C] -20...+50
Vibration resistance [G] 10 Sinus 5...2000 Hz acc. IEC 68-2-6

10 (RMS) Random noise 20...2000 Hz acc. IEC 68-2-36
15 Shock acc. IEC 68-2-27

Weight [kg] NG06: 3.6 / NG10: 6.5
Hydraulic
Fluid Hydraulic oil according to DIN 51524 ... 535, other on request
Fluid temperature [°C] -20...+60 (NBR: -25...+60)
Viscosity permitted	 [cSt]/
	 recommended 	 [cSt]/

[mm2/s]
[mm2/s]

20...400
30...80

Filtration ISO 4406; 18/16/13
Operating pressure max. [bar] 350 for ports P, A, B / max. 35 for port T at internal drain, 

250 (D1FE, D1FP: 350) at external drain / port Y max. 35 1)

Electrical
Duty ratio [%] 100
Protection class IP65 in accordance with EN 60529 (with correctly mounted plug-in connec-

tor)
Supply voltage / ripple [V] 22...30, electric shut-off < 19, ripple < 5 % eff., surge free
Current consumption max. [A] 3.5
Pre-fusing [A] 4.0 A medium lag
Input signal 	Code B, (K)	voltage
			   Impedance

[V]
kOhm]

+10...0...-10, ripple < 0.01 % eff., surge free, 0...+10 V P–>A (P–>B)
100

  		  Code E 	 voltage
			   Impedance

[mA]
[Ohm]

+20...0...-20, ripple < 0.01 % eff., surge free, 0...+20 mA P–>A
< 250

	   	 Code S	 current
			   Impedance

[mA]
[Ohm]

4...12...20, ripple < 0.01 % eff., surge free, 12...20 mA P–>A
< 250
< 3.6 mA = enable off, > 3.8 mA = enable on acc. NAMUR NE43

Input capacitance typ. [nF] 1
Differential input voltage max.
		  Code 0
		  Code 5

		  Code 7

[V]

[V]

[V]

30 for terminal D and E against PE (terminal G)
11 for terminal D and E against 0V (terminal B)
30 for terminal 4 and 5 against PE (terminal W )
11 for terminal 4 and 5 against 0V (terminal 2)
30 for terminal D and E against PE (terminal G)

Enable signal	 Code 5/7 [V] 5...30, Ri = > 8 kOhm
Diagnostic signal                  [V] +10...0...-10 / +12.5 error detection, rated max. 5 mA
EMC EN 61000-6-2, EN 61000-6-4
Electrical connection
		  Code 0/7
		  Code 5

6 + PE acc. EN 175201-804
11 + PE acc. EN 175201-804

Wiring min. 	 Code 0/7
		  Code 5

[mm²]
[mm²]

7 x 1.0 (AWG16) overall braid shield
8 x 1.0 (AWG16) overall braid shield

Wiring length max. [m] 50

1) For applications with pT>35 bar (max 350 bar) the Y-port has to be connected and the plug in the Y-port has to 
be removed.
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2. Safety Instructions

Please read the operation manual before installa-
tion, start-up, service, repair or stocking! Disregard 
may result in damaging the valve or incorporated 
system parts.				  
Symbols

This manual uses symbols which have to be fol-
lowed accordingly:

	 Instructions with regard to the warranty
				     
	 Instructions with regard to possible dam-
aging of the valve or linked system com-
ponents

	 Helpful additional instructions

Service

Workings in the area of installation, commissioning, 
maintenance and repair of the valve may only be 
allowed by qualified personnel. These are persons 
which have, because of education, experience 
and instruction, sufficient knowledge on relevant 
directives and approved technical rules.

3. Important Details

Intended Usage

This operation manual is valid for proportional 
directional control valves DFplus series. Any dif-
ferent or unintended usage is to be considered as 
not intended. The manufacturer is not liable for 
warranty claims resulting from this.

Common Instructions

Parker reserves the right for technical modifications 
of the described product. Illustrations and drawings 
within this manual are simplified representations. 
Due to improvement or modification of the product 
the illustrations might not match precisely with 
the described valve. The technical specifications 
and dimensions are not binding. No claims can be 
derived of it. Copyrights are reserved.

Liability		   

Parker does not assume liability for damage due 
to the following failures:

•	 incorrect mounting / installation	
•	 improper handling		   
•	 lack of maintenance		   
•	 unintended usage

Do not disassemble the valve! In case of 
suspicion for a defect please contact Parker.

Storage		   

In case of temporary storage the valve must be 
protected against contamination, atmospheric 
exposure and mechanical damages. Each valve has 
been factory tested with hydraulic oil, resulting in 
protection of the internal parts against corrosion. 
Yet this protection is only ensured under the fol-
lowing conditions:			    

	Outdoor storage or within sea and tropical 
climate will lead to corrosion and might dis-
able the valve!

Storage 
period

Storage requirements

12 months
constant humidity < 60 % as well 
as constant temperature < 25 °C 

6 months
varying humidity as well as 		
varying temperature < 35 °C
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4. Mounting / Installation

Scope of Supply

Please check immediately after receiving the valve, 
if the content is matching with the specified scope 
of supply. The delivery includes:

•	 valve
•	 operation manual
The central connector has to be ordered separately 
and is not included in the delivery.

	 Please check the delivery immediately after 
receiving the shipment for apparent dam-
ages due to shipping. Report shipment 
losses at once to the carrier and the sup-
plier!

Mounting	

•	 Compare valve type (located on the name plate) 
with bill of materials respectively circuit diagram.

•	 The valve may be mounted fix or movable in 
any direction.

•	 Check mounting surface for the valve. Uneve-
ness of 0.01 mm/100 mm, surface finish of 6.3 
µm are tolerable values.

	 Keep valve mounting surface and work en-
vironment clean!			 

•	 Remove protection plate from the valve moun-
ting surface	

•	 Check the proper position of the valve ports 
and the O-rings.

•	 Mounting bolts: 
	 D1FE/D1FP: 4 pcs. M5x30
	 D3FP/D30FP: 4 pcs. M6x40 
	 use property class ISO 4762-12.9

•	 	Bolt kits:
	 D1FE/D1FP: BK375 
	 D3FE/D3FP/D30FP: BK385

•	 Tighten the bolts crisscross with the following 
torque values:

	 D1FE/D1FP: 7.6 Nm 
	 D3FE/D3FP/D30FP: 13.2 Nm

	 Insufficient condition of the valve mounting 
surface might create malfunction!	

	 Incorrect mounting resp. bolt torque may 
result in abrupt leakage of pressure fluid on 
the valve ports.

Limits of Use

The valve may be operated within the determined 
limits only. Please refer to the “technical data“ 
section as well as to the “characteristic curves“ 
in the Parker catalogue HY11-3500/UK “Hydraulic 
Valves Industrial Standard”.			 

	Follow the environmental conditions! Unal-
lowable temperatures, shock load, aggresive 
chemicals exposure, radiation exposure, il-
legal electromagnetic emissions may result 
in operating trouble and may lead to failure! 
Follow the operating limits listed in the 
“specifications“ table!

Pressure Fluids

The following rules applies for the operation with 
various pressure fluids:

	This above information serves for orientation 
and does not substitute user tests among 
the particular operating conditions. In par-
ticular, no liability for media compatibility may 
be derived out of it.

Mineral oil: usable without restriction.
HFC: choose the right seal option.

For operation with the following pressure fluids 
please consult Parker:

	For detailed information concerning pressure 
fluids note VDMA-document 24317 as well 
as DIN 51524 & 51502.

Special gaskets may be available depending on 
the utilized fluid.
In case of doubt please consult Parker.

HFA oil-in-water emulsion
HFB water-in-oil emulsion
HFD unhydrous fluids (Phosphor-Ester)
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Electrical Connection

The valve is connected electrically by one common 
cable and a central connector.			 

The connection codes 0 and 7 require a 6 + PE 
female connector EN 175201-804.

	The female connector can be ordered sepa-
rately under article nr. 5004072.		

In case third party connectors are used, ac-
cordance to the relevant EMC directives must 
be ensured.

The connecting cable has to comply to the follow-
ing specification:

Cable type	 control cable, flexible, 
		  7 conductors, overall braid 	
			   shield			 
Cross section	 min. AWG16
Outer dimension	 8...12 mm
Cable length	 max. 50 m

	For cable lengths > 50 m consult Parker.		
	

The connection cable is coupled to the female 
connector by solder joints.
Skinning lengths for the connecting cable:

The connection Code 5 requires a 11 + PE female 
connector EN 175201-804.

	The female connector has to be ordered 
separately under article nr. 5004711.	

In case third party connectors are used, ac-
cordance to the relevant EMC directives must 
be ensured.

The connecting cable has to comply to the follow-
ing specification:

Cable type	 control cable, flexible, 
		  8 conductors, overall braid 	
		  shield			 
Cross section	 min. AWG16
Outer dimension	 12...15 mm
Cable length	 max. 50 m

	For cable lengths > 50 m consult factory.	

The connection cable is coupled to the female 
connector by crimp contacts.

Skinning lengths for the connecting cable:

Do not disconnect cable socket under volt-
age!

The shielding has to be assembled according the 
outline below: 

Ø
27

.5

A
F

22

M26x1.5 ~92

7/8-20
UNEF-2B

Ø
28

.6

max. 67

PG13.5
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Electrical Interfacing

Supply Voltage 

The supply voltage for the valve has to cover the 
range of 22...30 V. Valve is de-energized below 
19 V. The residual ripple may not exceed 5 % eff.

	The applied power supply must comply to 
the relevant regulations (DIN EN 61558) and 
must carry a CE-mark. The operating voltage 
for the valve must be free of inductive 
surges. Do not exceed the max. value of 30V! 
Higher voltage can lead to failure of the valve.

	The increased inrush current of the valve 
should be considered when selecting the 
power supply. A stabilized power supply with 
overcurrent limiting feature should not be 
used. Due to the inrush current of the valve 
the current limit circuit may respond prema-
turely and create problems during energizing 
of the supply voltage.

	The operation of the valve is blocked if the 
supply voltage polarity is interchanged.

	Each valve requires a separate pre-fuse of 4 
Amp semi time-lag.  Failure to observe this 
instruction may create irreparable damage 
of valve respectively incorporated system 
parts.

The backshell nut of the cable gland has to be 
tighten with a suitable tool. The target value for 
the tightening torque is 4 Nm. Tighten the cap nut 
with a torque of 5 Nm after attaching the female 
connector on the socket. 	

	 Incomplete tightening of backshell nut re-
spectively cap nut may result in undesired 
release of the connection as well as degrada-
tion of the water tightness.

	 When using female connectors of other 
manufacturers, the relevant regulations must 
be observed.				  

	The cable may only be connected to the 
female connector by authorized and qualified 
personnel. A short between individual con-
ductors resp. to the connector housing , bad 
soldering as well as improper shield connec-
tion may result in malfunction and breakdown 
of the valve.

	The mounting surface of the valve has to be 
connected to the earth grounded machine 
frame. The earth ground wire from the valve 
connecting cable as well as the cable shield 
have to be tied to the protective earth termi-
nal within the control unit. It is necessary to 
use a low ohmic potential connection be-
tween control unit and machine frame to 
prevent earth loops (cross section AWG 6).



Prop. Directional Control Valve
Series DFplusOperation Manual

13 Parker Hannifin Corporation

D_F_30 5715-687 UK.indd 16.09.21

=

~

V
A

F B

E C
G

D

+

Power supply

24 V

Command

0...±10 V

Diagnostics
valve stroke

Reference

Reference1)

0...±10 V
0...±20 mA
4...20 mA

B, K:
E:
S:

0 V

Wiring

Code 0, 6 + PE acc. EN 175201-804 Code 5, 11 + PE acc. EN 175201-804

Code 7, 6 + PE acc. EN 175201-804 + enable

=

~

V

+

Power supply

24 V

Enable

Command

+
5...30 V

0...±10 V

Diagnostics
valve stroke4 5

3 610
2 119 7

1 8

Pin 3 and 8 internally connected
Pin 9 and 11 internally connected
Pin 10 not connected

Reference

0...±10 V
0...±20 mA
4...20 mA

B, K:
E:
S:

0 V

0 V

Reference1)

=

~

V
A

F B

E C
G

D

+

+

Power supply

24 V

Enable

Command

0...±10 V

5...30 V

Diagnostics
valve stroke

Bezugspotential1)

0 V

0 V

0...±10 V
0...±20 mA
4...20 mA

B, K:
E:
S:

1) Do not connect with supply voltage zero.
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Code 
command 

signal

Command 
signal

Function
VCD 

actuator
Diagnostic 

signal

B

0…+10 V on 0…+10 V

0…-10 V on 0…-10 V

Overload     off 12.5 V

E

0…+20 mA on 0…+10 V

0…-20 mA on 0…-10 V

Overload     off 12.5 V

K

0…+10 V on 0…-10 V

0…-10 V on 0…+10 V

Overload     off 12.5 V

S

4…12 mA on 0…-10 V

12…20 mA on 0…+10 V

0…3.6 mA     off
Cable break,  

12.5 V

Overload     off 12.5 V

Code 
command 

signal

Command 
signal

Function
VCD 

actuator
Diagnostic 

signal

B

0…+10 V on 0…-10 V

0…-10 V on 0…+10 V

Overload     off 12.5 V

E

0…+20 mA on 0…-10 V

0…-20 mA on 0…+10 V

Overload     off 12.5 V

K

0…+10 V on 0…+10 V

0…-10 V on 0…-10 V

Overload     off 12.5 V

S

4…12 mA on 0…+10 V

12…20 mA on 0…-10 V

0…3.6 mA     off
Cable break, 

12.5 V

Overload     off 12.5 V

Valves NG06 Valves NG10

1)	 Diagnostic signal 12,5 V in error case. Spool moves 
in a defined postion, please see ordering code „spool 
position at power down“.

Enable input (only for Code 5 / 11+PE as well 
as Code 7 / 6+PE)

A signal voltage enables the actuator drive of the 
valve. Continuous operation of the valve requires 
a permanent voltage 5...30 V (e.g. the supply volt-
age). In case of disabling the signal the valve will 
reach its power down position spring-actuated 
independently from the command signal value.

	The enable function represents no safety 
arrangement against unwanted valve opera-
tion in terms of accident prevention regula-
tions.

Command signal input

The spool stroke is proportional to the command 
signal amplitude.

	The command input signal needs to be filtered 
as well as free of inductive surges and 
modulations. Due to the sensitivity of the 
valve a high signal quality is recommended. 
This will prevent malfunction.

	 The option 4...20 mA uses the “3.6 mA“ 
condition as breakdown-information. If the 
input signal line is interrupted, an evaluable 
failure information is available. In this case 
the actuator drive will be switched off. The 
drive will switch on when the input signal 
reaches a value of 3.8 mA, it switches off 
when the command falls below 3.6 mA. This 
determination follows the NAMUR-specifi-
cation NE43.

NAMUR is an association of users of process 
control technology.

Diagnostic output	  

A diagnostic signal is available. Its voltage repre-
sents the operating condition of the valve. 

	The output may drive a load of max. 5 mA. 
Exceeding of this limit leads to malfunction.
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Hardware requirements	

•	 PC with operating system from Windows® XP 
upwards	

•	 Interface RS232C 	
•	 display resolution at least 800 x 600	
•	 connection cable between PC and electronic 

module	
•	 memory requirement approximately 40 MB	

	 If your PC has no serial interface according 
to RS232C standard you require in addition 
an USB-RS232C adapter.

Cable Specification

	Attention! The valve electronic provides no 
USB interface, but can only be parametrized 
via an RS232C - connection. Therefore the 
usage of USB standard cables is not allowed 
and may result in damaging of valve respec-
tively PC.

Parametering interface

Parametrizing

Ordering code: 40982923

Plug for 
parametering interface

5. Operating Instructions

Spool Position at Power Down/Center Position

	For valves with zero lap spools, distinction 
must be made between hydraulic neutral 
position and power-down position. Neutral 
position is taken at neutral input signal, cor-
responding to zero position of the hydraulic 
symbol. When the valve is switched off – no 
supply voltage, no enable, current signal 
(code S) < 3,8 mA – zero lap valves take the 
power down position (approximately 10 % 
opening) according to the ordering code. For 
valves with overlap spools, neutral position 
and power down position are the same (zero 
position).

	Supply pressure must be ensured before 
valve is energized.

Solenoid Current Monitoring

If the actuator current time interval exceeds 10 
seconds, the actuator is switched off to prevent 
overheating. For normal operating conditions this 
state will not reached, but it may occur with a 
contaminated sluggish valve.

	 In this case the reason for the contamination 
should be rectified (hydraulic fluid exchange, 
filtration review, valve flushing).

The overcurrent shutoff condition may be resetted 
by the actions below:

Code 0: 	 Temporary disconnection of the supply 
	 voltage.

Code 5: 	 Temporary disconnection of the enable  
	 signal.

Code 7: 	 Temporary disconnection of the enable  
	 signal.

	 The shutoff of the VCD actuator due to over-
load will be indicated via the diagnostics 
output.

ProPxD parameterizing software

The ProPxD software permits comfortable param-
eter setting. Via the clearly arranged entry mask 
the parameters can be noticed and modified. 
Storage of complete parameter sets is possible as 
well as printout or record as a text file for further 
documentation. 

The PC software can be downloaded free of charge 
at www.parker.com/isde – see page “Support” or 
directly at www.parker.com/propxd. Please check 
periodical for updates.

	The cover plug has to be re-installed after 
completion of the parametrizing work.
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Program installation

Please check before installation if the above hard-
ware requirements are met. If your PC has already 
stored an older version of the “ProPxD” program, 
it has to be deinstalled by using the Windows® - 
system control feature.

Program installation sequence:

•	 terminate the execution of other programs
•	 execute the file “setup.exe”
•	 follow the instructions on the screen 
Answer the question, if an older version should be 
overwritten, with “ok”. During the installation you 
may change destination drive respectively instal-
lation path, if needed.

Please answer “ok” if at the end of the installation 
the program reports any system information. After 
successful installation the desktop display shows 
the ProPxD icon for starting the program.

Software Operating

Brief instruction for first startup:

•	 Connect the valve electronic to the supply voltage.

•	 Connect the valve electronic to a PC via the 
parametrizing cable.

•	 Start the operating program.

•	 After displaying the program respectively data 
base version a program window opens and the 
connected valve will be automatically identified 
(possibly a manual identification via the button 
“Receive all” is necessary).

•	 Select the desired version via the menu “Op-
tions/Optionen” with the menu item “Language/
Sprache”.

•	 The valve specific default parameters are already 
available within the parameter table.

•	 Parameter changes are possible via mouse or 
the arrow buttons on the bottom left within the 
program screen, also the parameter values may 
be edited via the keyboard.

•	 Modified parameters will be stored via the 
“Enter” key or via the button “Update list”.

•	 Parameters have to be nonvolatile stored on 
the valve via the button “save parameter”.

•	 The chosen parameters may be optionally 
stored on the PC via the “File”-menu with the 
menu item “Save as”, data retrieving is always 
possible via the function “Load file”

Extended functions:

The user software is segmented into 2 parameter 
ranges:	

•	 basic mode	
•	 expert mode	
For normal startup the basic mode is sufficient. 
It permits the setting of all application specific 
parameters to match the valve function with the 
task setting.	

In case of special applications the valve parameters 
may be adapted via the expert mode. The operating 
mode may be selected from the “Options”- menu 
and remains after terminating and re-start of the 
program.	

	Changing of expert parameters is only permit-
ted for qualified personnel. Incorrect settings 
may lead to malfunction! In case of parameter 
changes shut the drive down!

To prevent an unauthorized access for the expert 
mode, a password is requested. The name is 
“parker” and cannot be changed. Thus additionally 
to the button “Default” for loading of the default 
parameters, the button “Send parameter” appears 
in the “Expert”-operating mode. This button trans-
mits only the setting of one single parameter to 
the connected valve. Thus a quick tuning of single 
parameters is permitted during the setup. 	

	 A horizontal bar graph readout between 
the communication buttons shows the data 
transfer state.

	 Because the ProPxD program has also with-
out connection to the valve functionality, a 
manual pre-selection of the parameters is 
possible. After selection of the valve type via 
the menu “Options” the parameters may be 
set and stored for later transmission.

	 Note the design series while selection of the 
valve!

The “File” menu provides the functions “Printer 
setup”, “Print preview” and “Print”. The print pre-
view includes the option for parameter set storage 
as text file (format.txt) prior to further processing. 
The “Options” menu provides also the selection 
of the RS232C interface port via the menu item 
“Port”. Via the menu item “Load file” previously 
stored parameter sets may be loaded. 
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LED flashing signals of the valve electronics

enable valve  	OK: 	approx. 0.5 Hz (slowly, green)

disable valve  	OK: 	approx. 1 Hz (fast, green)

valve error:  		  approx. 10 Hz (very fast, green)

Closer information can be can be displayed via 
the ProPxD Parametrier software.

LED

Error code 
(additive)

Error description

0 no errors
1 over current
2 cable break command signal
4 cable break feedback signal
8 undervoltage error
16 bus communication error
32 hardware failure

Error code
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P1
Adjustment of zero position shifting (offset). 
To compensate for unbalances.

P3
MAX +

Adjustment of maximum signal span for positive output signal.
To match the command signal span to the valve operating range.

P4
MAX -

Adjustment of maximum signal span for negative output signal.
To match the command signal span to the valve operating range.

P7
MIN +

Adjustment of stroke step for valve side A at min. operating threshold.
To compensate for the overlap of the valve spool.

P8
MIN -

Adjustment of stroke step for valve side B at min. operating threshold.
To compensate for the overlap of the valve spool.

E17
option command

Adjustment of the command signal option.
To match the command signal input to the input signal mode.

E19
cable break detection 
command

Adjustment of the operating mode for the command cable break 
detection. To turn on resp. off of the cable break detection of the 
command signal at a selected command signal option of 4...20 mA.

E25
operating threshold

Adjustment of the MIN operating threshold.
To match the response sensitivity for the MIN-stroke step.

Individual Description of Basic Parameters

Parameter overview for basic mode

Parameter Description Unit
Parameter Range Default 

Setting
Comment

from up to
P1 Zero adjust % -90.0 90 0.0
P3 MAX channel A % 50.0 100.0 100.0
P4 MAX channel B % 50.0 100.0 100.0
P7 MIN channel A % 0.0 50.0 0.0
P8 MIN channel B % 0.0 50.0 0.0

E17 option command –

1 = ±10 V
2 = ±20 mA
3 = 4-20 mA
5 = ±10 mA

1 =  ±10 V
only displayed, 
not adjustable

E19
cable break detection 

command
– 0

0 (±10 V /
 ±20 mA)

0/1
code S0 only, 

only displayed, 
not adjustable1 (4...20 mA)

E25 MIN operating threshold 0.01 % 50 200 100

Adjustment parameters	

The available parameters may be divided into 
multiple groups and are characterized by different 
letters:	

S-parameters
P-parameters
J-parameters
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Parameter Description Unit
Parameter Range Default 

Setting
Comment

from up to

J8
Min supply voltage 

supervision
V 17 28 18

J9
Relay time out off range 

min supply voltage
ms 0 3200 1000

J12 Errorhandling

0 = 	 no fault acknowled-
gement necessary;

255 = 	 fault acknowled-
gement necessary;

768 = 	 no fault acknowled-
gement + fault 
report about diag-
nosis;

1023 = fault acknowledge-
ment + fault report 
about diagnosis

768

J8
Min supply voltage 
supervision

Adjustment of the minimal supply voltage:  
Below this supply voltage the valve switches off with an error message.

J9 
Relay time out off range 
min supply voltage

Adjustment of the runtime monitoring: 
The supply voltage must be at least constantly  before the valve is 
ready for operation.

J12 
Errorhandling

Adjustment of the fault response or  report: 
0 = no fault acknowledgement necessary  
255 = fault acknowledgement necessary  
768 = no fault acknowledgement + Fault report about diagnosis  
1023 = fault acknowledgement + Fault report about diagnosis

Overview for additional expert mode parameter

Individual description of additional expert parameters
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Failure message Description/corrective action
The Com Port is not available! Terminate the other program, or quit the message and select 

another RS232C port via the menu “Options > Port”. Afterwards 
reconnect the parametrizing cable.

Unable to open COM port Com port is not available. Quit the message and select another 
RS232C port via the menu “Options > Port”. Afterwards reconnect 
the parametrizing cable.

There is no module/valve 
connected or the communi-
cation is disturbed! Please 
check also the interface!

No data exchange possible. Either the electronic has been re-
moved, the port is mismatched, or the connection will be dis-
turbed by strong electrical fields. Check if the Com port is set for 
“9600, 8, 1. none, none” via the menu “Options > Port”.

Wrong password Retype the password, notice the exact spelling (case sensitivity).
Wrong input An unvalid character or a value outside the permitted range has 

been used at parameter entry.
Keep the entered param-
eters?

During parameter loading from the electronics memory the preset 
parameters from the left hand screen display may be rejected or 
maintained.

The chosen module/valve 
isn´t the same as the con-
nected hardware. Attention! 
Unsaved parameters will be 
lost.

In principle, parameters dedicated to a type which deviates from 
the connected valve may be edited. However, for data transmit-
ting the correct valve has to be connected. If parameters will be 
loaded from a valve which deviates from the selected one, the 
parameters from the left hand side screen display of the program 
will be overwritten.

The chosen hardware isn´t the 
same as the connected mod-
ule/valve.

The wrong valve type has been selected from the database, after-
wards the function “send all” has been executed.

Attention! Factory settings 
will be changed! Transmit 
anyhow?

Default parameters has been read out from the database instead 
from the valve via the function “receive all”.

file name.pxd already exists. 
Do you want to replace the 
file?

The file name already exists within the indicated directory. Select 
another name, another directory or overwrite the existing file with 
“OK”.

Error messages

Malfunctions when using the ProPxD software program will be indicated via appropriate failure messages.

Failure messages and corrective actions:

Air Bleeding of Hydraulic System	

During initial startup, after an oil change as well as 
after the opening of lines or valves the hydraulic 
system must be air bleeded.

Filter

The function and lifetime of the valve are strongly 
affected by the cleanliness of the fluid.

Purity level class of 18/16/13 acc. ISO4406 is 
required.	

Flushing				  

It is recommended to flush the pipelines by short 
circuiting the pressure and return lines. This pre-
vents the installation dirt from entering the valve.
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malfunction at hydraulic load runtime
- generally no function

- high frequent oscillation
- low frequent oscillation

- one way operation only
- speed variations at unchanging command

- different speeds depending on travel direction
- speed too low

- drifting without command
- poor dynamic
possible reasons for malfunction corrective actions

X hydraulic pump resp. motor defective replace hydraulic pump resp. motor
X X X X X X X drive overloaded reduce pressure resp. speed, increase valve size
X X X X X X X X valve contaminated clean pressure fluid, filter / flush valve

X X X hydraulic fluid too viscous / too cold change fluid grade, provide operational temperature
X X X too low oil level within tank refill pressure fluid

X X X filter contaminated replace filter
X X X X supply voltage too low keep supply voltage range

X supply voltage carries too much ripple reduce ripple
X X X command signal too low increase command signal

X command signal carries too much ripple reduce ripple
X X center position adjustment incorrect check center position adjustment

X X X X X contacts of central connector contaminated clean contacts / replace plug
X feed cable interrupted fix feed cable
X X X X X X X wiring sequence incorrect correct wiring sequence

X X feed cable without shielding change cable grade
X pilot pressure too low or failed increase pilot pressure to min. 20 bar

X X X pilot pressure too low increase pilot pressure to min. 20 bar
X pilot pressure too low increase pilot pressure to min. 50 bar

6. Trouble Shooting

Basis of troubleshooting is always a systematic 
approach.

	For suspect of a sluggish spool the valve 
may be flushed with clean pressure fluid.

	Troubleshooting in a hydraulic system requires 
detailed knowledge about function and 
construction of the system. Therefore the 
work may exclusively be performed by 
qualified personnel.

7. Accessories / Spare Parts

Accessories

The following accessories are available for the 
valve series DFplus:

Bolt kit

D1FE/D1FP 	 ordering code BK 375
D3FE/D3FP/D30FP 	 ordering code BK 385

Female connection

Code 0: 6+PE	 ordering code 5004072
Code 5: 11-PE	 ordering code 5004711
Code 7: 6-PE	 ordering code 5004072

  

Spare Parts

Seal kit NBR

D1FE/D1FP   	 ordering code SK-D1FP
D3FE/D3FP/D30FP  	 ordering code  SK-D3FP
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